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Release Notes for InduSoft Web Studio

InduSoft Web Studio v6.1 + Service Pack 6 + Patch 3
(Wednesday, June 09, 2010)

| ID || Type || Description |

Modified ViewerCfg.exe program in order to warn user when the

1055|| Change Request configuration file (Viewer.ini) is not properly created

|1446|| Change Request ||Modified screen editor to optimize memory allocation |

Changed the OPC Client DA to avoid errors when the OPC Server does

14 Ch R t
>8|| Change Request |\ eturn the canonical type for items.

|1582|| Change Request ||Changed the dump functionality in order to retrieve more information. |

Modified DRIVER task to properly create the Virtual Groups when there

1258 Issue are tags with Scan configured as Always and Screen

Modified the product to support the compiled version of the
GraphiScript (scriptgraphics.isc). It allows the user to remove the
editable graphic script file from the application (scriptgraphics.gis) in
order to protect the intellectual property. This option will be available
only when the user enables the use of screen files in the SCC format
("SaveScreenScc" parameter of the [Screen] section of the
<ApplicationName>.app file). Please refer to the product documentation
for further information.

1265 Issue

Modified the Driver task to support tag field writes when the option

1271 I
ssue "Send Every State" is selected.

Modified "Print Preview" functionality to work properly with all

1331 [
33 >sue documents

Fixed problem that the Driver Runtime was not taking modifications
1382 Issue made on the Standard Driver Sheets when the "Enable Read When Idle"
field was active.

|1433|| Issue |Updated SNMP files for WinCE

Modified ISSymbol to avoid problems with certain devices that would

1469 Issue . .
cause the runtime to freeze after running for a few hours

Modified driver task to properly handle the reading actions for Virtual
1470 Issue groups and Standard Driver Sheets when there are tags configured with
scan for Screen and Always

Modified Trend Legacy object to optimize data acquisition for long

147 I
8 >sue periods of time

Modified ISSymbol to create a new internet session using an application

147 I
? >sue name when connecting with IIS

Fixed problem with dialogs on Alarm Control object that were not being
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|1495|| Issue ”translated when the Translation functions were being used

1501 lssue Modified I1ISSymbol to allow commands from objects placed behind the
GRID object to be executed also on Web Thin Clients

1503 lssue Modified e-mail solution in order to support multiples EHLO answers
from the different SMTP Server

|1515|| Issue ||Modified the scheduler to support bit fields as triggering events.

1584 lssue Fixed issue when starting the runtime with a large number of startup
screens
Modified the the development environment to store the user

1585 Issue application selection in the user folder instead of the program files
folder.

1594 lssue I;/g;il;y the product to support alarms on tags configured on row over

|1596|| Issue ||Improved the replace capability when working with huge applications.
Fixed issue that causes the Viewer to disconnect from the server when

1591 Issue . . . .
an action done in the Viewer takes a long time.

1610 lssue F|)fed the SetTranslationFile function in order to work properly on
WindowsCE.

InduSoft Web Studio v6.1 + Service Pack 6 (Monday, November
30, 2009)

| ID || Type || Description |

|1141|| Requirement ||Added hardkey license support for CEView. |

Updated the software to ensure full compatibility with Microsoft

127 Requi
5 equirement Windows 7 (both 32-bits and 64-bits).

Improved CEView to run on Windows CE devices that do not support
1278|| Requirement |[DCOM. Only the OPC DA interface is still not supported, because it
specifically requires DCOM.

Added the entry "SecureViewerWatchDogTag" to the application file
(application_name.app). This instructs the Secure Viewer to watch a
specified tag (by default, the system tag ServerTime_), and if the tag
value does not change before the timeout is reached -- indicating that
the Server has failed or the Secure Viewer has otherwise lost its
connection to the Server -- then the Secure Viewer automatically
switches to the designated backup Server. The application file entry can
be edited to specify a different tag.

1387|f Requirement

Added "Disable Commands" option to the screen attributes, to allow

1389| Requirement . . . . e
q programmatic disabling of all user interaction in a specific screen.
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Modified the Secure Viewer to be able to run remotely, with
independent tag values and security, even when running on the same
computer as the Server (i.e. Studio Manager). This can be enabled by
selecting the option "Force remote behavior" in the Secure Viewer
Configuration utility (ViewerCfg.exe).

1022

Change Request

Introduced the SecureViewerReload function (from the Built-in Scripting
Language) to reload the Secure Viewer with a different configuration file
during runtime.

1085

Change Request

Fixed an issue where the operator could not use Remote Desktop Client
(RDC) to access the software running on another station. The issue was
introduced in a previous release, when the hardkey licensing mechanism
was modified to prevent mulitple simultaneous accesses of the same
hardkey.

1108

Change Request

Improved the external databases interface to provide more informative
log messages, especially when the maximum number of database
connections is reached.

|1190|

Change Request

|Modiﬁed the Application Tags database to support up to 65488 rows.

1216

Change Request

Improved the external database interface to support SQL CE 3.0 and 3.5.
Please see the documentation for information on how to configure these
database connections.

1259

Change Request

Implemented UNICODE capabilities when sending alarm e-mails or
sending e-mails using the SendEMailExt function call.

1311

Change Request

Improved the OPC Server module to automatically re-register itself
whenever it is started, so that it always runs with the correct DCOM
credentials.

1360

Change Request

Updated the software to ensure full compatibility with Microsoft
Windows 7 (both 32-bits and 64-bits).

1384

Change Request

Improved the database interface to support the latest .Net connector
for MysSQL.

1388

Change Request

Changed the layout of the Trend Control object to make it easier to
select pens during runtime. This change affects Windows PC clients only,
not Windows CE clients.

1392

Change Request

Modified the external databases interface to refresh hostname every
time a new connection is made.

1407

Change Request

Modified CEServer and the Support Information dialog to indicate the
correct operating system version for Windows 7 and Windows 2008.

1418

Change Request

Improved the email interface to allow custom port numbers for SMTP
and POP3 servers.

664
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Fixed an issue where, on Windows 64-bit operating systems, the
operator could use keyboard shortcuts to switch tasks even when the
security settings -- specifically "Task Switch Enabled" and "Disable Task
Manager" -- were configured to prevent it. See also items 1083 and
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| [1397.

Updated the novaPDF printer utility to work correctly on Windows 64-bit

712 I
>sue operating systems and Windows XP Embedded devices.

Modified expression parsers to properly indicate an error when an
836 Issue expression uses incorrect syntax, such as "(Function)" instead of
"Function()".

Modified the Trend Control object to handle floating point values in the
"Axes > Time" field when Period Type is set to "Time Before Now". Also,
the object will now update the value of the tag configured in the "Axes >
Time" field according to user input during runtime (e.g. when the
object's X-axis scroll bar is used to change the time period being
displayed).

917 Issue

Fixed an issue that prevented the Service created by the "Service
Configuration" utility (Tools > Service Configuration) from starting
automatically when the computer boots. Also, the name of the Service
will now show the full product name instead of only the company name.

922 Issue

Modified the "Service Configuration" utility to run as Administrator on
926 Issue Windows Vista, even when the user does not explicitly choose to run it
as Administrator.

Fixed an issue where, on Windows Vista, new application projects would

928 I
>sue sometimes be saved in locations other than the user's Documents folder.
Fixed an issue where the Trend Control object did not adjust for Daylight
931 Issue . . . .
Saving Time on Windows CE devices.
932 lssue Fixed an issue where a Linked Symbol object would sometimes lose its
custom property values when the Master Object was changed.
Fixed an issue that sometimes caused the Remote LogWin utility to close
934 Issue . .
when attempting to save the log to disk.
Modified the Viewer to properly display scroll bars when the size of an
953 Issue . . . . .
application screen is larger than the size of the Viewer window.
954 lssue Fixed an issue that caused the External Databases interface to insert a
NULL value for Boolean tags, instead of the correct value of 0 or 1.
|961 || Issue ||Modified Event logging to save the User Name with the Event.
Updated the context-sensitive help to include new items in the user
964 Issue .
interface.
973 lssue Modified the algorithm of the Global Replace feature to properly replace

properties from Linked Symbols.

Fixed an error that occurred when an application project contained the
980 Issue maximum number of tags allowed by the program license and then the
user tried to change the properties of a tag.

981 Issue Fixed an issue that sometimes caused the Div/Add and Min/Max settings
in a Drivers worksheet to be ignored, resulting in raw rather than scaled
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| ” ||tag values being written to the target device.

Fixed an issue where the Global Replace tool did not replace tags in
986 Issue . . .
Linked Symbols in closed Screen files.
Fixed an issue where the PrintSetup function (from the Built-in Scripting
994 Issue .
Language) would not accept the printer selected by the user.
Modified the Reports task to properly handle situations where the user
995 Issue .
forgets to close the curly brackets around a tag or expression.
Fixed an issue that caused the Convert Resolution command (Tools >
997 Issue . . . .
Convert Resolution) to disable automatic screen scaling.
|998 || Issue ||Fixed logon issues in Mobile Access. |
Fixed the FileWrite function (from the Built-in Scripting Language) to
999 Issue work properly when the same text file is being used by more than one
Grid or Trend Control object.

Fixed an issue where the Mobile Access server incorrectly incremented
the number of connected users when a user disconnected without
logging off — usually by closing the Web browser — and then attempted
to reconnect.

1002 Issue

Improved the performance of the Windows CE thin clients (both Web
1006 Issue Thin Client and Secure Viewer) when accessing an application with an
extremely long Global Procedures file.

Fixed the Replace button (in the Object Properties dialog) to replace

1007 I
00 ssue string values in Linked Symbols.

Improved performance when communicating with several devices at the

1011 Issue .
same time.

Fixed the RunGlobalProcedureOnServer function (from the Built-in
1017 Issue Scripting Language) to work properly when the application is running as
a Windows Service.

Modified the remote debugging tools (Remote Database Spy and
1018 Issue Remote LogWin) to allow the user to cancel while tags are being loaded
from the Server.

Fixed the Execution Environment tool to download the correct firewall

102 I
023 >sue configuration to Window CE devices.

1029 lssue Fixed an issue where, on certain laptops running Windows Vista 64-bit,
installing the software would disable the keyboard and touchpad.
Fixed an issue that caused the Trend Control object to print only a blank

1034 Issue i .
page on certain printer models.
Fixed the SetViewerInFocus function (from the Built-in Scripting

1035 Issue . . L
Language) to work properly when the application viewer is minimized.
Fixed an issue where a Combo Box object with the Position dynamic

1040 Issue

applied to it sometimes changed values unexpectedly.
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Fixed the Wait function (from the Built-in Scripting Language) built-in
1047 Issue . . . .
function Wait() to work properly when used in VBScript.
Fixed an issue where, on some Windows CE devices, the Group column
1048 Issue .
of an Alarm Control object would not update properly.
1052 lssue Fixed an issue where the Mobile Access server would sometimes reject
new connections after running for a long time.
1059 lssue Fixed an issue that caused Remote Agent (running on Windows CE) to
move to the background when the Setup button was clicked.
1067 lssue Fixed th_e Alarm Control object to delete messages properly from the
alarm history.
Fixed the "history-to-text" conversion utility (HST2TXT.exe) to properly
1070 Issue ) . . .
adjust for Daylight Saving Time.
|1072|| Issue ”Improved counting of connected users in Mobile Access. |
Fixed the ProductVersion function (from the Built-in Scripting Language)
1078 Issue . . .
to return the correct version number when running the Viewer module.
Fixed an issue where, on Windows 64-bit operating systems, the
1083 lssue operator could use keyboard shortcuts to switch tasks even when the
security settings -- specifically "Task Switch Enabled" and "Disable Task
Manager" -- were configured to prevent it. See also items 664 and 1397.
Fixed an issue where an object with both the Position and Bargraph
1090 Issue . . .
dynamics applied to it would not behave properly.
1091 lssue Fixed an issue where the Viewer module sometimes closed improperly
after running an application that had the Virtual Keyboard/Keypad open.
Fixed the Trend Control object to prevent overflow when drawing the
1103 Issue .
pens. The overflow for huge values could cause unexpected behavior.
Modified the CEView PRO License and Runtime to support up to five
1107 Issue . . . . -
different communication drivers in the same application.
Modified the Format function (from the Built-in Scripting Language) to
1110 Issue .
properly handle real values that are too big.
1112 lssue Fixed an issue where the FileCopy function (from the Built-in Scripting
Language) would not copy files to a computer's root directory.
Fixed an issue where deleting a tag from the application database would
1148 Issue . .
sometimes cause the Development Environment to close unexpectedly.
Modified the bargraph dynamic to work correctly on Windows Mobile
1159 Issue 6.1. The previous implementation would not work when bargraph is at
0%.
Modified CEView to be able to run Math worksheets and Scripts from
1163 lssue only the compiled files (*.mac and *.isc) in the application's Config
folder. The source files (*.mat and *.is) can be safely deleted to protect
intellectual property.
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Modified the historical file saving to generate a new file if the user
updates the month/year, the previous implementation would look only
for the day.

1175

Issue

Updated the e-mail features to work properly with some specific e-mail
servers.

1178

Issue

Fixed problem with execution environment, it would fail to connect if
you keep connecting and disconnecting using a serial connection.

1193

Issue

Fixed problem when removing tags from the Application Tags Database
in certain application with too many Tags of Class Type

1206

Issue

Fixed the Trend Control object to properly draw a pen that has a
Min/Max range outside of its Lo Limit/Hi Limit range. (For example, a
Min/Max range of 0—19 and a Lo Limit/Hi Limit range of 20-80.)

1207

Issue

Fixed an issue where, when a new application project was created with a
Target Platform of "CEView", the Fmt setting of the Text I/O dynamic
was always locked to "Auto".

1210

Issue

Fixed the Virtual Keypad to avoid truncating exponential values when
the associated tag's specified Max is in scientific notation.

1218

Issue

Fixed an issue in Linked Symbols where editing a custom property with a
direct tag reference would break indirect references (a.k.a. pointers) to
the same tag. For example, #tagName:myStringTag and
H#tagName:@myStringTag. Now, when you change the direct tag
reference, the indirect reference will be correctly updated to match.

1256

Issue

Fixed an issue in Linked Symbols where, if different class members and
tag fields are associated with the same property (e.g.
#Propl:TagA.MemX->B0, #Prop1:TagA.MemrY->B1), then the Symbol
Properties dialog wouldincorrectly include the class member in the
editable/replaceable value. Now, the Custom Properties dialog will only
show the main tag as editable/replaceable.

1263

Issue

Modified Auto logoff feature for CEView to work properly on some
specific devices.

1276

Issue

Fixed an issue in Linked Symbols where, in specific circumstances, the
software would crash after the user edited a custom property in the
Object Properties dialog.

1312

Issue

Fixed an issue in Alarms where the "Apply Period of Time to Each Day"
option would not work when the historical data was being saved to an
external database.

1317

Issue

Fixed an issue where, when running an application in the Web Thin
Client on Internet Explorer 8, cascading application dialogs would be
disabled.

1321

Issue

Modified the CnfEmail function to properly handle an empty string as a
parameter for pop server on the 64 bit operating systems.

Fixed an issue where executing a Global Replace while screens were
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”open might have caused the development software to crash.

Issue
Fixed an issue where the runtime server may have frozen when running
1338 Issue . . . .
an application that called database functions in the Startup Script.
Fixed an issue where the runtime server may have crashed if the
1344 Issue s . . . .
application's Global Procedures script was edited during runtime.
Fixed an issue where running an application with Smart Message objects
1383 Issue . . . . .
linked to text files would cause the runtime application viewer to crash.
1390 lssue Removed "Testing Hard Key" message from output log, because it is
irrelevant to runtime performance.
1393 lssue Fixed i§sue with FOR NEXT when using math scripts on specific Windows
CE devices.
Fixed an issue where the operator could use keyboard shortcuts to
1397 Issue switch tasks or close the application even when the security settings
were configured to prevent it.
1416 lssue Modified Support Information window to properly display remote device
information on Windows 7 and Windows Vista.

InduSoft Web Studio v6.1 + Service Pack 5 (Thursday, January 15,

2009)

Lo |

Type

|| Description |

| 461 |

Requirement

”Modified the SNMP interface to support customized MIB files. |

467

Requirement

Created the option to "Read after writing" in the OPC Client worksheet.
This option is useful to synchronize the values from the OPC Server with
the values from the OPC Client, especially when the same item from the
OPC Server can be updated either by the OPC Client or by the device
(e.g.: PLC) connected to the OPC Server.

469

Requirement

The driver task was modified to eliminate the limit of 81 characters when
reading/writing string data from/to the device(s). This item will only be
available for drivers using the new Driver Toolkit and that use the Driver
Standard to set the string values.

473

Requirement

Created the SNMPSet() built-in function, which allows the user to write
values to OID addresses, using the SNMP protocol.

476

Requirement

Created the SMA (Studio Mobile Access) solution, which allows the users
to visualize online alarms and tag values from any remote device, such as
a cell phone, PDA, or regular computer, using any web browser capable
of displaying HTML pages.

478

Requirement

Created a new option on the Help menu, called “Support
Information”. This option displays information about the local system,
and about the (remote) target system (if any) connected through the
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Execution Environment interface. The information displayed by this
option is especially useful when requesting technical support.

500

Requirement

It was created the option to run the product (runtime) as a “Service”, in
addition to the existing default mode to run the product as a regular
“Windows Application”.

502

Requirement

Created option to compress files before sending them through the
Execution Environment to the Remote Agent. Consult the product
documentation (Execution Environment) for further information about
how to enable this option.

| 464

| Change Request

|Improved the internal structure of the Security System.

471

Change Request

Improved the performance when scanning multiple channels along with
computed channels from the FlukeDAQ device.

546

Change Request

The FileWrite() built-in function was modified to support UNICODE
format in addition to the already supported ASCII format.

549

Change Request

Improved the error message displayed when an ActiveX control
configured on the screen cannot the loaded. The improved message
describes the possible causes of the error.

555

Change Request

Enhanced the development environment to set the startup state of the
following tasks to "Automatic" (instead of "Manual") when creating the
first worksheet for each one of them, respectively: OPCClient, TCPClient,
Database Client, DDE Client, and ODBC Client.

558

Change Request

Created an option in the "Project Settings --> Runtime Desktop" dialog to
execute only the command for the topmost object, when clicking on
objects that overlap.

565

Change Request

Improved Import Wizard to configure the OPC Client Task to start
automatically after creating OPC worksheets and set the scope of
imported tags to "Server" instead of "Local".

583

Change Request

The Text I/0 dynamic was modified to display the warning message
"Invalid entry. Please enter a numeric value." during the runtime, when
the user attempts to enter a non-numerical value for a numeric tag
(Boolean, Integer, or Real).

598

Change Request

The default file type supported by the Import Wizard for the "TwinCAT
PLC Database" was modified from "SYM" to "TPY".

605

Change Request

The message "Verify Application was completed successfully.

Check the Output window for a complete log of this command" will be
displayed after finishing the execution of the Verify Application
command from the Tools menu.

606

Change Request

It was created a warning message to be displayed when saving a Trend
worksheet, as long as the changes implemented in the Trend worksheet
will result in incompatibility with the proprietary history files created
previously by the same application.
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section [ISSymbol]) for the <ApplicationName>.APP file. When this
parameter is set with the value 0 (default), ISSymbol (Viewer, Secure
Viewer, or Web Thin Client) sends every state (tag values) to the Server
only for tags that are configured in the Driver or OPC Client worksheet,
as long as the option "Driver and OPC" from "Project --> Settings -->
Communication" is set to "Send Every State". When this parameter is set
with the value 1, ISSymbol (Viewer, Secure Viewer, or Web Thin Client)
sends every state (tag values) to the Server for all tags.

614

Change Request

There were created additional options for project resolution when
creating a new project or when converting the resolution of the current
project. Furthermore, it was created an option where the user can
customize any resolution (width and height) for the project, different
from the pre-defined options.

634

Change Request

The CEView program was modified to start the application faster,
especially for applications that have thousands of lines configured in the
Global Procedures interface.

636

Change Request

Created read-only field SendEveryState, which is automatically set by the
run-time and forces the graphical interface to report all the tag changes
to the Server Module.

639

Change Request

Created an option to configure a custom tag to trigger the MAIN DRIVER
SHEET read commands. This parameter can be configured in the
<ApplicationName>.APP, as follows: [Options]
MainDrvAlwaysTrigger=BlinkSlow

643

Change Request

The project (<ApplicationName>.APP file) can be configured to download
external ActiveX controls and register them automatically on the Thin
Client station. This algorithm was modified to show an error message if,
after downloading and installing the control, we don't find it in the
registry (probably because the user specified a wrong CLSID). Also
modified to download the control using relative path (see Technical
Reference manual for details)

652

Change Request

Changed the TCP Client task to support IP:PORT in the "Server IP
Address" field.

654

Change Request

The screen editor was modified to resize objects proportionally (keeping
the ratio between width and height) when using the handlers drawn on
the corners of the selected object. When pressing the SHIFT key, the user
is able to resize the object changing the ratio between its width and
height.

655

Change Request

The OPC Client task was modified to improve its reliability and report
errors, if any, to the Output Window (LogWin) when connecting or
communicating with third-party OPC Servers.

657

Change Request

The TCP/IP Client task was modified to set the quality of the tags
configured in its worksheets to BAD when the TCP/IP Client detects
errors when trying to communicate with the remote TCP/IP Server. In
order to enable the TCP/IP Client task to modify the quality of tags, the
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new parameter "SetQualityToBadOnError" from the [TCP] section of the
<ApplicationName>.APP must be set to 1.

The Linked Symbol was enhanced, allowing the user to group Custom
Properties in different categories and filter the properties per category
663 | Change Request |[when editing the objects. The new syntax supported by the Linked
Symbol is "#Category.CustomProperty:DefaultValue", where the
"Category" and the "DefaultValue" are optional.

CEView was enhanced to support the Picture object, available from “Edit

711 | Ch R t
ange Request 15 past Link”. CEView supports picture files in the formats BMP and JPG.

The default setting from "Project --> Setting --> Communication -->
717 || Change Request ||Driver and OPC" was modified for new applications. The new default
setting is "Send every state" instead of "Send last state".

The Alarm/Event Control was enhanced to support a third optional

780 Change Request column when configuring the initial sort.

Changed default for the Virtual Keyboard Show Hint configuration in
794 | Change Request |[Project->Settings->Runtime Desktop. The default is now enabled for new
projects.

The graphic interface was enhanced to support background pictures for

839(| Ch R t
ange Request < reens with resolution as large as 10000 x 10000 (pixels).

The built-in SaveAlarmFile() function was enhanced to support the
877 Change Request ||Database format, in addition to the Proprietary and Binary formats,
which were supported previously.

|924 || Change Request ||Increased the size of the "Yes" and "No" buttons in the confirm dialog. |

Modified the algorithm implemented by the 'Replace’ feature of the
'Object Properties' dialog window, in order to handle properly specific
455 Issue syntaxes, such as: Array indexes with expression (e.g.: Tag[TagID+1]), and
class members and tag fields associated to the same custom property
(e.g.: #Prop:Class.Member and #Prop:Class.Member->Field).

Improved the algorithm for the Alarm Deadband Time to make sure it
458 Issue works properly, even if the internal clock of the station moves
backwards.

Modified Secure Viewer to display the tag values properly when
462 Issue switching to screens after logging with different users more than once on
the startup screen.

Modified Web Thin Client control (ISSymbol) to support the "Print

4 I
65 >sue Preview" option from the Web Browser (Internet Explorer).
Modified the DirDelete() built-in function to avoid deleting all files from
480 Issue the root directory of the C drive when executing the function with no

parameters.

The algorithm that sorts the addresses in the communication driver
484 Issue MAIN DRIVER SHEET was modified to guarantee that the addresses are
properly organized in virtual communication groups.
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The error messages indicating that VBScript is not supported by the
device are no longer displayed when the user switches from one screen
to another. When the device does not support VBScript, the error
message will be displayed only once when running the application.

486 Issue

Modified the GetLine() function to return the value of the first row of the
text file properly when the format of the file is UNICODE. The initial
UNICODE char (OxFEFF) used to indicate the file format is properly
ignored by the function.

541 Issue

The graphic interface was modified to support the DayOfYear system tag

>42 Issue both on the Server and on the Thin Client stations.

Modified Execution Environment to support the "Microsoft ActiveSync"
543 Issue connection type when linking the development environment with
devices running Windows Mobile v5.0 or v6.0.

The RunVBScript() built-in function was modified to avoid memory

544 Issue .
leaking.
| 548 ” Issue ”Grid column editor was modified to avoid exceptions.
Modified the product to guarantee that the user is able to add shared
550 Issue . . . .
tags in applications created under Windows Vista.
Modified the Trend Control to avoid generating overflow errors in
554 Issue VBScripts when a pen configured in the Trend Control has a very low
value (e.g.: 1e-100).
The Trend Task was modified to support String tags. When
562 lssue the Trend History Format is set to "Proprietary”, the value of the String
tag is converted to a numeric value before being saved into the history
file.
The Viewer process was modified to display the value of the
563 Issue " e . ..
Description" tag field properly (e.g.: TagName->Description).
575 lssue Modified the linked symbols to display property tooltips properly even
when using grouped properties.
The screen editor was modified to keep the relative position among the
581 Issue selected objects, even when moving them through the borders of the
screen.
Fixed the memory leaking issue when generating and displaying event
596 Issue .
messages with more than 64 characters (each).
597 lssue The email notification from the Alarm Task was modified to avoid
crashing after attempting to send several emails unsuccessfully.
Modified the Import Wizard for OPC Server Databases to support more
601 Issue than 4096 tags from the OPC Server, as long as the current license allows
it.
Removed the "Remote" option from the Import Wizard for Studio
603 Issue s e .
Database to avoid instability issues on the current architecture.
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The graphic module was modified to guarantee that the values for tag
fields are properly retrieved, even when using indirect tags (@TagName-
>TagFieldName) to access the tag field value.

618

Issue

Modified the Grid object to avoid errors when opening a screen with a
Grid object (Data Source = Class Tag) where the same member of the
class tag was configured in more than one column of the Grid object. The
error would occur only if the Grid object was configured in the startup
screen.

623

Issue

Modified the Viewer task to avoid exception errors when defining an
expression for custom properties in object dynamics (e.g.:
#CustomPropertyName:TagName>10). The error occurred only when
running the application under Windows CE.

641

Issue

The development environment was modified to support the built-in
functions StartTask(), EndTask(), and IsTaskRunning() on any interface
that supports expressions, even if the project is set to CEView (Target
System).

648

Issue

The Smart Message object was modified to display the last message
configured in the object, even when it is configured to blink.

650

Issue

The Security System was modified to make sure that Studio is able to
load the application when the option "Use preferentially the Remote
Security System" from the Security System is enabled, even if the
Remote Security System station is not available.

658

Issue

The driver task was modified to avoid exception errors when running
projects configured with more than 4095 tags in the MAIN DRIVER
SHEET. The problem occurred only with drivers that did not impose the
maximum block size for virtual groups from the MAIN DRIVER SHEET.

659

Issue

The Driver task was modified to guarantee that the writing commands
from the MAIN DRIVER SHEET have higher priority than the reading
commands from the same MAIN DRIVER SHEET.

668

Issue

The Thin Client control (ISSymbol) was modified to improve the
performance when switching screens, especially when the Primary
Server is not available and the Thin Client station is connected to the
Secondary Server (redundancy).

674

Issue

Improved Import Wizard to configure the Driver Task to start
automatically after creating driver worksheets.

698

Issue

The Execution Environment was modified to make the Serial Port
configuration persistent.

703

Issue

The Remote Agent for PC (e.g.: Windows XP/Vista/2003 Server) was
modified to avoid conflicts when trying to run it along with the Studio
runtime.

707

Issue

The settings from the “Project Settings” dialog were updated to match
the actual default settings for title bar, menu, and status bar.
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The device driver for the USB Hardkey was updated to solve
incompatibility issues with 64-bits operating systems, such as Windows
Vista 64-bits or Windows 2008 64-bits.

716

Issue

The PrintWindow() built-in function was modified to run properly under
Windows CE.

739

Issue

The Studio ADO Gateway (StADOSvr.exe) was modified to support
timestamp with milliseconds precision for the history tasks: Alarm, Event,
and Trend.

740

Issue

Resolved problem with daylight savings when running the Fluke DAQ
devices.

752

Issue

Modified algorithm for Print Preview to prevent problems when using
the system close button (upper right x) to close the Print Preview
window.

758

Issue

Modified VBScript compilation to properly handle pointers to integers.
The current algorithm was causing the assignment @MylntegerPointer=1
to be handled as @MylIntegerPointer=True and as a result the integer tag
being pointed to would receive -1.

759

Issue

The following tag fields were modified to assume the value 1 when
writing any value different from 0 to them: “Ack”, “AlrDisable”, and
“Unack”.

764

Issue

Fixed problem with Trend Control when saving the Min/Max values for
pens that have not been added to the trend run-time. The trend was
saving the Min/Max as O for these pens and if the user inserted them
after loading the configuration (which happens when you close and open
a trend screen) the pen would be inserted with Min/Max of 0.

767

Issue

The behavior of the State field used to filter messages from the
Alarm/Event Control object was modified to support the following
options: 0: No filter (all states) 1: Active and not acknowledged 2: Active
and acknowledged 3: Normalized and acknowledged 4: Normalized and
not acknowledged

771

Issue

The Import Wizard for the “TwinCAT PLC database” was modified to
avoid setting the type of String tags imported from the TPY file as Real
tags.

777

Issue

The behavior of the screen dynamics was modified to avoid triggering
command dynamic when the object is updated by other dynamics.

786

Issue

Modified the option "Import Strings" in the translation tool to include
the header texts from objects that support column header (Alarm, Trend
Legend and Grid).

796

Issue

Modified the built-in function Hst2Txt() to prevent exceptions when
invalid parameters are specified.

799

Issue

Fixed problem with functions DateTime2Clock, ClockGetDate and
ClockGetTime when running on Windows Vista.
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Modified the screen editor to avoid asking if the user wants to save
800 Issue screens with the Trend object, even if the user did not implemented
changes on it.

Modified the development environment not to reset tag values when the
run-time is running and the same application is loaded in the

4 I
80 >sue development environment by using the command "RunStudio
AppName" or by double clicking in the application file.
813 lssue Improved the performance of TWCAT import wizard and implemented
algorithm to ignore pointers when importing.
360 lssue Modified the built-in Virtual Keyboards to display the correct ASCII

character when pressing the space bar on the Virtual Keyboard.

Trend control was modified to resolve problem with break interval when
861 Issue the break happens between the first two samples and then to
consecutive samples.

The graphic module for Windows CE was modified to avoid displaying "#"
879 Issue characters instead of actual values. The problem would occur when
configuring specific expressions with Custom Properties.

Fixed problem with Pocket PC that would generate exceptions when

892 I
>sue switching between screens in some specific Windows CE devices.

The device driver for the USB Hardkey (beige) was updated to avoid
893 Issue . .

memory leaking that could result in a system crash.

Modified hardkey license interface to address compatibility issues with
895 Issue .

Windows 2008.

Modified the Viewer module not to reload screens when tags with
908 Issue . .

retentive parameters have their parameter values changed.
911 lssue Modified Linked Symbols capability to support combo boxes even on

HMIs with ARMV4I processors.

Fixed problem with Text I/O when used on Screens with Hide option
913 Issue enabled. The hide would cause the Text I/O to be loaded only in the first
time that you open the screen.

InduSoft Web Studio v6.1 + Service Pack 6 + Patch 3 - Known
Issues (Wednesday, June 09, 2010)

| ID || Type || Description

The column to delete alarm messages from the Alarm/Event object,
604 Issue when configured as the first column, is displayed too small on Windows
Vista. [WORKAROUND]: Configure any other field as the first column.

626 lssue Remote on-line screen update does not work when downloading large
screen files to specific devices. [WORKAROUND]: Stop the application

http://www.indusoft.com/zip/webstudio61/Manuals/ReleaseNotes.xml 05/08/2010



Page 16 of 17

| ” ||and execute the "Send Application" command.

The web tunneling gateway installer does not complete successfully on
windows 7 and server 2008. The Web Tunneling gateway also does not
function as expected under windows Vista. The behavior exist on both 32
and 64 bit [WORKAROUND]:

715 Issue

The Message Box from VBScript is displayed behind the screen when
called from a background script. [WORKAROUND]: Call the Message Box
from the Graphic Script, based on the condition triggered by the
background script.

757 Issue

When the user has only one pen in the trend and the Min/Max is not
specified, the trend uses the point color to show the label instead of
using the Y Axis font color. [WORKAROUND]: Add a second pen to the
Trend Control and make the second pen invisible.

873 Issue

Thin Client stations take a long time to load some screens for the first
time. [WORKAROUNDY]: Configure objects on the screen with the tags
used in the screen script. For example, transparent rectangle with tags
in the Caption.

884 Issue

Evaluation mode does not work on Windows Vista and Windows 7.
894 Issue [WORKAROUND]: Run the development environment at least once as
Administrator (right-click > Run as Administrator).

Driver task writes old value to the PLC when using Send Last State and
1089 Issue causes value flicker when using Send Every State [WORKAROUND]: Use
the option Send Every State

Removing an alarm worksheet does not remove the corresponding
alarm configuration in the Tag Properties->Alarms-Integer/Real Type
tab. [WORKAROUNDY]: After you delete the Alarm worksheet, go to Tag
Properties and manually delete the individual alarms on the tag.
Otherwise, delete all of the lines in the Alarm worksheet before you
delete the worksheet itself.

1192 Issue

Batch file load fails on Trend object when using Database format for
Trend task [WORKAROUND]: Lookup the batchHistory table, retrieve the
Start_Date and End_Time, calculate the Duration and pass those
paramters to the Trend Object without using Batch on it.

1201 Issue

Execution Environment is not handling well when an app was already
deployed to a WinXP system and you want now to download it to a
WinCE targe, and vice-versa [WORKAROUND]: Close the application and
edit the RemoteAppDir key on the APP file using notepad.

1314 Issue

Cascading popup windows do not work correctly on web thin client and
1322 Issue secure viewer [WORKAROUND]: If you click again on the button to open
the 2nd Popup Window it will come to the front

Text in linked symbols is not imported by the Import String Application
feature of the Translation Tool [WORKAROUND]: * add the linked
symbol(s) to some temporary screen * right-click on the linked symbol(s)

1335 Issue
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to unlink it * save and close the screen * import your strings using the
translation tool * delete the temporary screen.

SendEmailExt is creating an invalid "To" header [WORKAROUND]: A work
around is to include a display name in your address specification when
you invoke the SendEmailExt () as follows, SendEmailExt
("subject","body","John Smith <John.Smith@indusoft.com>")

1602 Issue
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